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WHAT’S NEW? 

 

NEW TEMPLATES 

FRS102 Tax accounting 

In response to customer demand we have expanded

accounting.  The new FRS102 sheets extract information from your tax computation to prepare the tax accounting 

disclosures for your accounts.  This provides greater efficiency for your tax compliance processes as the draft tax 

computation for tax accounting purposes and the tax computation for the Return can be prepared in the same file, 

using much of the same data.   

The tax accounting sheets are developed from A and have standard 

• Tax Account 

• Accounts disclosures  

• Proof of tax 

• Gross timing difference 

• Net timing differences  

We have created standard working papers for dealing with tax rates, timing differences

The screen shot below shows the Tax Account 
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expanded the ONESOURCE Ireland functionality to include tax 

The new FRS102 sheets extract information from your tax computation to prepare the tax accounting 

disclosures for your accounts.  This provides greater efficiency for your tax compliance processes as the draft tax 

omputation for tax accounting purposes and the tax computation for the Return can be prepared in the same file, 

s are developed from A and have standard computation sheets covering:

dard working papers for dealing with tax rates, timing differences, non qualifying assets

The screen shot below shows the Tax Account – FRS102 sheet. 

 

unctionality to include tax 

The new FRS102 sheets extract information from your tax computation to prepare the tax accounting 

disclosures for your accounts.  This provides greater efficiency for your tax compliance processes as the draft tax 

omputation for tax accounting purposes and the tax computation for the Return can be prepared in the same file, 

computation sheets covering: 

qualifying assets etc.  
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This is the new tax accounting sheet for Accounts disclosures 

We have created a Quick Reference Guide to explain the functionality and to help with its use.  The 

accounting guide is appended for your convenience.

Revenue eBrief No. 52/15: Accounting Standards 

We have reviewed the recent eBrief and can confirm that the new FRS102 sheets can 

transitional arrangements for IFRS and spreading of change in basis adjustments.

Group 

In addition to the Tax Accounting module, we have expanded 

module.  The Group module is available for 2015 periods onwards.  It 

module file, extract relevant group information from company files, manage 

back.  This provides an efficient and robust process for mana

information to be readily seen on a group wide basis.

A Quick Reference Guide is available to explain this new feature and to help with its use.  

appended for your convenience. 
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is is the new tax accounting sheet for Accounts disclosures – FRS 102. 

 

We have created a Quick Reference Guide to explain the functionality and to help with its use.  The 

appended for your convenience. 

: Accounting Standards - Transitional Measures and Arrangements

and can confirm that the new FRS102 sheets can be used to deal with the 

transitional arrangements for IFRS and spreading of change in basis adjustments. 

 

In addition to the Tax Accounting module, we have expanded ONESOURCE functionality to include an Irish Group 

able for 2015 periods onwards.  It enables you to link company files to a group 

extract relevant group information from company files, manage offsets centrally and then push amounts 

back.  This provides an efficient and robust process for managing items like group relief and enables pertinent 

dily seen on a group wide basis. 

uide is available to explain this new feature and to help with its use.  The Group guide is 

 

We have created a Quick Reference Guide to explain the functionality and to help with its use.  The FRS 102 tax 

Transitional Measures and Arrangements 

be used to deal with the 

functionality to include an Irish Group 

link company files to a group 

centrally and then push amounts 

ging items like group relief and enables pertinent 

The Group guide is 
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The screen shot below shows the Group summary, this summary lists all the members of the group and provides a 

summary of the total income available to relieve and 

group module, the tax position and the losses forward position.

 
 

 

Below is a screen shot of the Trading losses matrix.

with surrenders and claims relating to losses (including trade, excepted trade and leasing), capital allowances, 

charges and R&D credits within a group of companies.

Loss making companies are displayed in rows and the profit making companies are displayed in columns with a 

summary of the profit company profits listed by type of profit at the foot of the schedule.  Thi

information in order to assist you in making the loss offset decisions.
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n shot below shows the Group summary, this summary lists all the members of the group and provides a 

tal income available to relieve and surrenderable losses with details of any claims made in the 

ses forward position. 

Below is a screen shot of the Trading losses matrix.  The group module contains nine group relief matrices to deal 

with surrenders and claims relating to losses (including trade, excepted trade and leasing), capital allowances, 

harges and R&D credits within a group of companies. 

Loss making companies are displayed in rows and the profit making companies are displayed in columns with a 

summary of the profit company profits listed by type of profit at the foot of the schedule.  This provide

information in order to assist you in making the loss offset decisions. 

n shot below shows the Group summary, this summary lists all the members of the group and provides a 

details of any claims made in the 

 

group relief matrices to deal 

with surrenders and claims relating to losses (including trade, excepted trade and leasing), capital allowances, 

Loss making companies are displayed in rows and the profit making companies are displayed in columns with a 

s provides additional 
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XBRL Accounts information 

As set out in our April update, Revenue Online Services released an update to their CT1 online filing service that 

impacted any electronic submission for the 2014 financial year filed after 28 March 2015.  This did not impact the tax 

calculation, but mandated a series of new questions / disclosures around your XBRL accounts filings.  The questions 

are on a new P sheet which was created as part of the update and, although not new to this 8.0 release, some users 

may not yet have been required to use it.  For 2015 this new sheet is a master and, as such, always present within 

the Personal Information folder in the navigator pane. 

Expression of doubt 

ROS now require that details of expressions of doubt are included with the return itself rather than in an 

accompanying letter.  The P sheet used previously to input these has therefore been extended to deal with long 

periods of account and has been linked into the CT1 for both periods. 

This sheet can be developed into your file from P – Information for the return using Develop > Administration > 

Expression of doubt. 

 

FA 2014 CHANGES 

 

Film investment relief (FA 2014 s24) 

A new D sheet called ‘Film Corporation Tax Credit’ has been added to allow the entry of relevant information for 

companies making a film corporation tax credit claim.  However, because the claim may only be made in an 

amended return, this sheet has been disabled for normal use.  Should you wish to develop the sheet into a file 

please contact the ONESOURCE support team.  

Amended returns 

Revenue Online Services have confirmed that third party software cannot be used for making ROS amendments to 

returns already electronically filed with them.  ROS amendments may only be input online using the ROS digital 

certificate that was used for filing the original return and, as such, cannot be made using third party software. 

R&D Expenditure credit changes (FA 2014 s26) 

The requirement for companies to take account of base year (2003) expenditure when calculating qualifying R&D 

expenditure has been removed for relevant periods commencing on or after 1 January 2015.  

Windfall tax on land changes (FA 2014 s31) 

The 80% rate of capital gains tax on gains from the disposal of land subject to rezoning no longer applied with effect 

from 1 January 2015.  Where a windfall disposal is entered after this date users are now asked to confirm that the 

higher rate should still apply. 

Trades with intangible assets (FA 2014 s40) 

This change removes the 80% cap on the aggregate amount of capital allowances, and any related interest expense, 

which may be offset in any accounting period against trading income of the relevant trade in which the intangible 

assets are used.  Deductions are however still restricted to 100% of the trading income from that relevant trade.  We 

have therefore amended the warnings given where amounts exceed those allowed. 
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De-grouping charge tax rate (FA 2014 s41) 

This technical amendment clarifies when tax becomes due and payable in respect of chargeable gains/capital gains 

arising under s623 TCA 1997 on a company leaving a group.  The rate of tax to apply to the disposal is the rate that 

applied at the time of the original intra-group transfer. 

 

In order to manage this, a new sheet “Chargeable Gains Arising on Company Leaving A Group” should be 

developed for these gains rather than the “Capital Disposal Calculation” sheet normally used for disposals.  By using 

this new sheet the rate in force at the time of the original transfer will be automatically applied. 

 

The sheet is designed to allow you to deal with the situation where more than one chargeable gain arises on de-

grouping by inserting a column for each asset affected.  Both non development and development land gains are 

dealt with and the sheet automatically applies the correct rate of capital gains tax dependent upon the transfer date 

entered, grossing up the gain for inclusion in total profits where applicable. 

 

There is however no place to report s623 capital gains on the CT1 consequently they are not included in the ROS 

calculation.  The ONESOURCE self assessment calculation will include them which will give rise to a difference on 

filing. 

Disclosure of tax avoidance schemes (FA 2014 s88) 

A new sheet, developed from P, has been created for disclosing tax advantaged transactions entered into that fall 

under the Mandatory Disclosure Regime.  Please note that it is only possible to file details of one scheme. 

This sheet can be developed into your file from P – Information for the return using Develop > Administration > 

Disclosable transactions. 

 

 

WHAT’S CHANGED? 

ONESOURCE PLATFORM 

E-filing 

A new e-filing wizard enables users to file returns directly from ONESOURCE without the need to separately upload 
CT1 files to ROS. 
 
 

 
 
 
 
When filing the first return for a company, users will be 
asked to select the appropriate digital certificate to use 
by selecting the “Manage credentials” option. 
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The certificate should be selected and password entered. The choice of certificate will be retained by ONESOURCE 
by default as will the password should the user select the remember password box. 
 

 
 
 

 
 
 
 
 
 
Users now have the option to either e-file the return or 
to just validate the file (perform an early check for any 
errors if you are not yet ready to file). 

 

 

 

 

Results returned by ROS are presented 

immediately to the user as well as being stored in a 

file specific to the company and period. 
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CORPORATE TAX 

No gain / no loss disposals shown on Capital Gains Summary 

Where indexation reduced a gain to nil the disposal was not previously displayed on the Capital Gains Summary 
sheet.  Following user requests, these are now shown. 

Finance leases assets brought forward and additions split out 

Previously a single column existed on the finance lease sheet for the entry of both leases brought forward and 
leases entered into during the period.  This single column has now been split into brought forward and current year 
columns.  This is clearer for users and assists with deferred tax workings in the new J sheets. 

2015 CT1 changes 

There is a new Sec. 917K hard copy approved version of the CT1 for periods ending in 2015 incorporating all the 
updates that have been made to the official CT1 form. 

Amounts claimed/surrendered as group relief 

As part of the inclusion of the new group module, the P sheets used to categorise group relief claims and surrenders 
for completion of the CT1 have been re-written.  These sheets now take values directly from the G1 and G2 sheets 
for group relief claimed and surrendered.   
 
There is still the requirement to confirm that all the companies satisfy the requirements for entitlement under Sec. 
411-418 TCA 1997 on the P sheet for ‘Amounts claimed as group relief’.  We have added in validation to ensure that 
the selector confirming eligibility is set. 
 

Rental analysis sheets 

Enhancements have been made to both the non ring fence and the ring fence rental analysis sheets to calculate the 
taxable lease premium and include it in the total rental income if applicable.   
 
We have added a selector “Lease premium taxable under Sec.98?”  which when set to “Yes” will display a new 
section for calculating the taxable premium.  There are sections for entering: 
 

• Premium payable under the lease 

• Period of the lease 
 
The taxable lease premium is then calculated and added to the total rental income. 
 

CPO disposals 

The updated 2014 e-filing schema and 2015 e-filing schema contain validation that indicate ROS now require CPO 
gains to be allocated to one of the four Initial/Later periods shown on page 26 of the CT1 and e-filed accordingly.  
We have amended ONESOURCE so that these values are returned in compliance with the new validation and 2014 
and 2015 files can continue to be lodged.   
 
However, in the calculation of the capital gains tax assessment ROS are effectively doubling up the gains by taxing 
both the total CPO and the constituent amounts broken down into the four boxes.  This will give rise to a difference 
when filing.  For capital gains tax there is no requirement to agree with the ROS assessment and it is the 
ONESOURCE assessment that is filed. 
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FULL LIST OF CHANGES 

 
A full list of changes has been included as an Appendix to these release notes. 
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APPENDIX – FULL LIST OF CHANGES 

 

 

Category Item Change Made Internal Ref 

E-filing Missing Tags from 

previous years 

Six elements were not tagged and so were not being 

e-filed.  Tags have been added for 2015 files 

644703 

E-filing ROS - 

PositiveNegativeAmount 

The wrong value was being returned for Shareholders 

funds on R130 if these were negative 

645015 

E-filing Bugs with 2014 Schema Four elements were not being e-filed 657703 

E-filing Schema check for 

Tonnage Tax 

Two elements were not being e-filed 647033 

678449 

E-filing New sheet for 

Expression of doubt 

A new sheet has been added for the entry of this 

information 

687853 

E-filing New sheet for company 

category 

Two new CT1 pages have been added to link to the 

new P1 iXBRL information sheet 

687868 

E-filing Additional notes for CT1 

is set to Yes for both 

periods 

The flag to confirm that additional notes have been 

entered in the CT1 has been split for long periods 

692589 

E-filing PRRT Certain Profit Resource Rent Tax amounts were not 

being filed for long periods 

695235 

Bug Capital allowances and 

Shipping trades 

Writing down allowances available within a shipping 

trade were not being deducted from taxable profits 

600483 

Bug Company/Shareholder 

Tax Ref check Incorrect 

The warning given was incorrect where an incorrect 

format was used for the tax reference number 

entered on the Associates Details sheet 

601896 

Bug REIT Case IV income 

breach of condition - not 

being taxed 

Amounts entered on A for REIT breach of condition 

amounts were not being taxed 

603602 

Bug Spurious warning if call 

a trade "Trade" in multi 

trade file 

Users can now name a trade simply “Trade” in a multi 

trade file without giving rise to an error.  

603605 

Bug A3: Case IV R&D 

Expenditure Clawback 

doubles up for long 

periods 

For long periods, the income in the main period was 

being incorrectly included in both the main and stub 

periods results.  The stub period profit was correctly 

included in only that period. 

604745 

Bug Investment income - 

REIT cells not summing 

properly 

Case III & V REIT income entered on the Investment 

Income sheet was not always being taxed 

609246 

Bug A3: Use of trade losses 

against 12.5% dividends 

doesn't take account of 

losses already used 

Trading losses available to offset against dividends 

were not previously being reduced by amounts 

already set against other income 

611239 

Bug D9 Change in basis 

column sum not 

working 

The sum in the final column was not always picking up 

the required values 

621063 

Bug Excepted trade group 

relief values on CT1 

The total amount of group relief shown on page 9 of 

the CT1 was sometimes incorrect for excepted trades  

698627 
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Bug Error needed at O3:C13? Error message amended for post relevant periods 656608 

Bug Loss brought back 

looking at wrong period 

for stub 

The value shown for losses brought back on the losses 

sheet was incorrect for the stub period for a long 

period of account 

698754 

Bug VBR doesn't take 

account of charges 

already set against 

Foreign Case III 12.5% 

dividends 

Losses available for value based relief were not being 

reduced by amounts already set against non-Irish 

dividends taxable at 12.5% 

622348 

Bug Allowance claimed for 

capital expenditure on 

scientific research (Sec. 

765) 

Trading receipts were not being taxed and the value 

fed through to the CT1 did not take account of 

deductions for current year expenditure (nor was this 

number being e-filed) 

702110 

Bug P4 Directors 

Remuneration Date Bug 

The accounting period end date for stub periods was 

incorrect and not all amounts were being e-filed 

705623 

Enhancement P sheet clean up -  rows 

62 to 66 

Removed items that are no longer needed 519988 

Enhancement E: Display columns when 

disposal gives nil gain? 

Disposals where indexation gives no gain now shown 

on Capital Gains Summary 

551266 

Enhancement C10 Finance leases - b/f 

not split out 

Additional columns added to allow easier tracking 

between existing and new finance leases 

551503 

Enhancement A2: Case V capital 

allowances has c/f for 

stub period 

Removal of unnecessary cells on Loss Summary (no 

affect on the computation) 

568794 

Enhancement Tidy up D9 Minor changes to margins and display controls 572207 

Enhancement Finance lease tidy up Minor changes to titles to make clearer 656566 

Enhancement Protect cells on A2 and 

A3 

Certain formula cells have been locked to prevent 

accidental change by users 

656600 

Enhancement Ireland Director PPS 

Number Validation 

Validations have been added to P3 and P4 to warn 

users if the PPS entered is not in the correct format 

536400 

Enhancement R&D links into CT1 Enabled a deduction for R&D credits brought back 

from the following period 

685714 

Enhancement Group auto completion 

of the P sheets and CT1 

Group relief categorisation for the CT1 is now 

automatically populated on the “P sheets” 

690705 

FA 2014 

change 

Film investment relief  A new sheet has been activated to allow entry of 

details for this relief 

631808 

FA 2014 

change 

R&D Expenditure credit 

changes 

Reference to the 2003 base year expenditure is no 

longer required 

631812 

FA 2014 

change 

Windfall tax on land 

changes 

Users warned that Windfall disposals should not be 

entered after 01/01/2015 

631816 

FA 2014 

change 

IP transfers - nil gain/ nil 

loss 

Warnings around 80% restriction on deductions for IP 

amounts is removed 

631826 

FA 2014 

change 

De-grouping charge tax 

rate to be used  

A new sheet has been created to tax disposals at the 

rate that applied at the time of the earlier transfer 

631833 

FA 2014 

change 

Disclosure of tax 

avoidance schemes 

A new sheet allows the entry of the transaction 

number for any tax avoidance schemes used 

631927 

FA 2014 

change 

Remove windfall gains 

from return forms 

These disposals are no longer reported 657446 
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INTRODUCTION 
 
The new Group module enables you to extract relevant group information from company files, manage 
this centrally and then push amounts back.  This provides an efficient and robust process for managing 
items like group relief and enables pertinent information to be readily seen on a group wide basis. 
 
Group files can be created for 2015 periods onwards. 
 

BRIEF OVERVIEW OF MODULE 
 
Group files are created from the new file menu by selecting Group in the “Choose return type” section.  
 
File > New > Ireland corporation tax 
 

A: Group summary 
 
A summary is presented for each group company, showing profits, group relief and tax etc. 
 

B: Group relief matrices 
 
Individual loss matrices are included for users to enter group relief allocations for the following loss types: 
 

• B:  Trading losses 

• B2: Leasing losses 

• B3: Trading losses b/f s396C 

• B4: Excepted trade losses 

• B5: Trade charges 

• B6: Restricted trade charges 

• B7: Case V capital allowances 

• B8: Management expenses 

• B9: General charges 

• B10: Restricted non-trade charges 

• B11: Excess R&D credit 
 
 

O: Group members 
 
Administrative details are shown on O for each group member e.g. date company left group. 
 

W: Company information 
 
A ‘W sheet’ will be added to the group file for each company linked and relevant information inserted from 
the company file. 
 

X: Company information 
 
An ‘X sheet’ will be added to the group file for each non-OCT company developed. 
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HOW TO USE GROUP 
 

This guide will work through an example to show you how you should 
example, we have an accounting period ending on 31/12/2014 and files created b
and outside of it: 
 
 
1. Create your group file from File > New > Ireland corporation tax

 
The period end and last period end dates should be the same as for your company files

 
 

2. Go to File > Link > Add companies
 
Browse to the .ABC file for the company you wish to add (ensuring you pick the correct accounting 
period) and press OK.  
 

Note: You can add more than one company

Should you mistakenly include a company then it can be simply removed using the 
companies command. 

Ireland: Group Quick Reference Guide 

work through an example to show you how you should use the Group Module
have an accounting period ending on 31/12/2014 and files created both within ONESource 

File > New > Ireland corporation tax and select Group

The period end and last period end dates should be the same as for your company files

Add companies to add companies to the group 

Browse to the .ABC file for the company you wish to add (ensuring you pick the correct accounting 

You can add more than one company at a time by holding down the Shift key

 
 
 
 
 
 
A ‘W sheet’ will be added to 
the group file for each 
company linked
information 
company file.
need to separately import 
information as this is done 
automatically.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Should you mistakenly include a company then it can be simply removed using the File > Link > 

use the Group Module.  In this 
oth within ONESource 

and select Group 

The period end and last period end dates should be the same as for your company files. 

Browse to the .ABC file for the company you wish to add (ensuring you pick the correct accounting 

at a time by holding down the Shift key 

sheet’ will be added to 
roup file for each 

company linked and relevant 
information inserted from the 
company file.  There is no 

separately import the 
information as this is done 
automatically. 

File > Link > Remove 
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3. Add non-OCT companies to group
 
Should there be any, information for companies created outside of ONESource can be added by 
developing a sheet for each one from Develop 
 
Develop > Non OCT company 
 
An ‘X sheet’ will be added to the group file for each non
otherwise be automatically picked up from
group relief. 
 

 
 
 
4. Sort 
 
An optional Sort button is included on each of the A, B and O sheets and this can be used in a variety of 
ways to help highlight the data you want to see.
 
The rows on the Summary O and A schedules can be sorted according to whichever column you select 
e.g. alphabetically or by amount of Corporation tax due by pressing Sort and then selecting your chosen 
column. 

Ireland: Group Quick Reference Guide 

OCT companies to group 

nformation for companies created outside of ONESource can be added by 
sheet for each one from Develop on O: 

sheet’ will be added to the group file for each non-OCT company and information that 
automatically picked up from OCT files should be entered here e.g. losses available for 

An optional Sort button is included on each of the A, B and O sheets and this can be used in a variety of 
ways to help highlight the data you want to see. 

the Summary O and A schedules can be sorted according to whichever column you select 
amount of Corporation tax due by pressing Sort and then selecting your chosen 

nformation for companies created outside of ONESource can be added by 

OCT company and information that would 
OCT files should be entered here e.g. losses available for 

 

An optional Sort button is included on each of the A, B and O sheets and this can be used in a variety of 

the Summary O and A schedules can be sorted according to whichever column you select 
amount of Corporation tax due by pressing Sort and then selecting your chosen 
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Sort on the Group relief B schedules is even more powerful
 

 
 
 
5. Review the values being brought into the Group Module
 
Once all companies have been added you can review their tax position on A.
 

  

Ireland: Group Quick Reference Guide 

Sort on the Group relief B schedules is even more powerful as you can sort by either row 

Review the values being brought into the Group Module 

Once all companies have been added you can review their tax position on A. 

row or column. 
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6. Enter group relief 
 

Note: It is best practice to deal with all group relief entries from within Group, posting these 
down to the company files. 

 
Now we can allocate losses between companies on the ‘B sheets’.  On each, columns are shown for 
companies with profits available to offset and rows for those companies with losses. 
 
Losses already claimed on other B sheets are shown at the foot of each column. 
 

 
 
 
Claims between companies are entered as a positive number in the relevant matrix cell. 
 
There is no need to complete all of the group relief schedules or to do them in a prescribed order. 
 

Note: Date joined group and date left group is shown for each company (if relevant) on 
each matrix to aid the user, it is not taken account of in the amounts showing as 
available for surrender or claim. 
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7. Go to File > Link > Update Companies
 
If you don’t want to update a company then “Allow update of comps” can be set to No on the O sheet for 
companies on a case by case basis.
 

 
 
8. Review your choices 

Once group relief has been pushed down to the company files you can review the 
summary sheet A.  Ensure the overall position has changed as you intended and that no errors have 
been created in the company files themselves.

Sheets can be printed as normal should you 
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Companies to push the group relief down to the company files.

If you don’t want to update a company then “Allow update of comps” can be set to No on the O sheet for 
companies on a case by case basis. 

Once group relief has been pushed down to the company files you can review the result
summary sheet A.  Ensure the overall position has changed as you intended and that no errors have 
been created in the company files themselves. 

printed as normal should you require a hard copy. 

to push the group relief down to the company files. 

If you don’t want to update a company then “Allow update of comps” can be set to No on the O sheet for 

 

result on the Group 
summary sheet A.  Ensure the overall position has changed as you intended and that no errors have 
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LIMITATIONS 

Co-terminus periods 
Currently, only periods of account of up to twelve months are supported and theses should all be 
coterminous with the Group period chosen. 

Companies can only be linked to one group file 
Companies can be linked to a single group file.  Where you wish to add to a different group, the company 
would first have to be removed from the first.  If you have deleted the group files that you wish to remove 
a company from then please contact Support. 
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INTRODUCTION 
 
Due to changes in Irish accounting standards, all companies must switch to either IFRS or FRS102 for 
accounting periods starting on or after 1 January 2015.  ONESOURCE Corporate Tax supports tax 
accounting under FRS102.  For early adopters of FRS102, the new FRS102 sheets will be available for 
tax accounting from 2015 onwards.  
 
The new FRS102 sheets extract information from your tax computation to prepare the tax accounting 
disclosures for your accounts.  This provides greater efficiency for your tax compliance processes as the 
draft tax computation for tax accounting purposes and the tax computation for the Return can be 
prepared in the same file, using much of the same data. 
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BRIEF OVERVIEW OF SHEETS 
 
The FRS102 tax accounting sheets are developed from the A Schedule via the Develop menu.  
 
Develop > Tax accounting > FRS102 Tax account – I/S approach 

Tax Account: J sheet 
The Tax Account details all current and deferred tax balances from opening to closing, including amounts 
charged to equity or Other Comprehensive Income (OCI).  The “C/F per comps” column is the suggested 
closing tax balances, as calculated by ONESOURCE.  You must, however, confirm these figures are the 
correct figures for the accounts by entering amounts into the “C/F per accounts” column.  If you are happy 
with the figures in the “C/F per comps” column, a button is available to automatically populate the 
accounts values. 

Tax accounting disclosures: J2  
This sheet provides you with your tax accounting disclosures for your accounts under FRS102, including 
the reconciliation to total tax charge.  Limited data entry should be required on this sheet. 

Proof of Tax : J3 
This sheet reconciles the expected tax charge on the profit or loss per the accounts to the actual total tax 
charge.  All reconciling items are then allocated to a disclosure caption automatically (with the option to 
reallocate for different disclosure, as appropriate).  

Gross timing differences: J4 
This sheet pulls through information from the tax computation in respect of timing differences including for 
example fixed assets, short term timing differences and losses.   You can allocate balances to OCI or 
equity as appropriate and, if relevant, this is where you would choose not to recognise assets. 

Net timing differences: J5 
Using the information from J4, this is a summary sheet which tax affects the gross timing differences to 
calculate the opening and closing deferred tax balances.  The tax rate used for the deferred tax balances 
can be overridden on the far right of the screen, for instance if an asset/liability will reverse against higher 
rate profits. 
 
We then have some working papers to support the calculations in the main sheet. 

Tax input sheet: JW 
Here you can override the tax rates used to calculate the deferred tax balances and to perform the tax 
reconciliation.  There are also a number of selectors which allow you to customise what you see in the tax 
accounting sheets. 

Fixed asset timing differences: JW2 
This sheet supports the “Fixed asset timing differences” row on J4.  It pulls in items from the fixed asset 
sheet and supporting sheets and also all capital allowances sheets and amalgamates them to calculate 
the overall gross timing difference in respect of fixed assets.  

Non-qualifying, exempt and other assets: JW3 
Non-qualifying items or items that need to be stripped out of the qualifying fixed asset timing difference 
can be entered on here. 
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Optional sheets 

Disclosure Narrative: J1 

This sheet provides example narrative to support the tax accounting figures in your accounts.  The 
narrative can be amended as appropriate to your disclosure and will roll forward to the subsequent 
period. 

Group relief supporting sheet: J6 

On here you can analyse your group relief and other payment balances across different periods. 

Foreign branch fixed assets: JW4 

Allows you to analyse foreign branch fixed assets amounts separate to the Irish fixed asset amounts and 
recognise them at the branch rate if appropriate. 

Tax payment: RA_2 

A new tax payment sheet has been added to support the tax account and is developed from ‘A’. 
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HOW TO USE THE ‘J’ SHEETS
This guide will work through an example computation to show you how you should complete the 
sheets.  In this example, we have an 
 

 
 
1. Complete your draft tax computation.
 

This can be prepared in as much or as little detail as 
 

2. Go to Develop > Tax accounting
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SHEETS 
work through an example computation to show you how you should complete the 

an A4 - Adjustment to Profit sheet as follows: 

 

omplete your draft tax computation.   

ared in as much or as little detail as is required for your tax accounting disclosures. 

Tax accounting > FRS102 Tax account – I/S approach to develop the ‘J’ sheets.

 

From this information, we can expect to 
see some permanent differences in 
respect of the disallowable expenses.  We 
should also see some fixed asset timing 
differences in respect of the depreciation 
and capital allowances, and also some 
short term timing difference movement.

The first sheet you will see is 
the Tax Account. This tracks 
the movement between 
opening and closing values 
for both current and deferred 
tax. 
 
The current tax charge for the 
period from the 
pulled through automatically 
to the “Charged/(credited) to 
I/S” column. 
 
Also on this sheet you can:

• Allocate 
deferred tax amounts to 
equity. 

• Allocate current and 
deferred tax amounts to 
Other comprehensive 
Income (OCI)

 

work through an example computation to show you how you should complete the ‘J’ 

required for your tax accounting disclosures.   

develop the ‘J’ sheets. 

From this information, we can expect to 
see some permanent differences in 

of the disallowable expenses.  We 
should also see some fixed asset timing 
differences in respect of the depreciation 
and capital allowances, and also some 
short term timing difference movement. 

The first sheet you will see is 
the Tax Account. This tracks 

movement between 
opening and closing values 
for both current and deferred 

he current tax charge for the 
period from the ‘A’ sheet has 
pulled through automatically 
to the “Charged/(credited) to 
I/S” column.  

Also on this sheet you can: 

Allocate current and 
deferred tax amounts to 

 

Allocate current and 
deferred tax amounts to 
Other comprehensive 
Income (OCI). 
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Ensure that your brought forward and carry forward figures are populated correctly on 
 
 
 
 
 

 
 

 
 

Either manually type the same numbers into the 
this column button provided. 
 

 

Note: We suggest that the “C/F
on the ‘J’ sheets is complete.

 
We will now work through the other sheets before returnin
figures.  We shall start by reviewing our gross timing differences
  

Quick Reference Guide 

that your brought forward and carry forward figures are populated correctly on the Tax Account

 

ither manually type the same numbers into the “C/F per accounts” column or click the 

 

F per accounts” column is completed when all the other work 
sheets is complete. 

We will now work through the other sheets before returning to ‘J’ to enter our carry forward per accounts 
figures.  We shall start by reviewing our gross timing differences, as explained in the next section

In the first year of using 
the ‘J’ sheets you will 
need to populate the “B/f 
per accounts” column on 
‘J’ for any current tax 
amounts.  

The deferred tax brought 
forward figures should be 
entered on 
will pull
sheet. On roll forward, all 
of the brought forward 
numbers will be populated 
automatically.

Until these are populated 
you will have an amount 
showing in the “Difference 
in provis
accounts” row.

 

The “C/F per comps” figures are the 
current and deferred tax amounts 
calculated by ONESOURCE, based 
on the information you have entered 
in the draft tax computation. 

 

Button provided to 
automatically populate the 
“C/F per accounts” 
column. 

 

the Tax Account.   

the Click to populate 

column is completed when all the other work 

g to ‘J’ to enter our carry forward per accounts 
, as explained in the next section. 

In the first year of using 
the ‘J’ sheets you will 
need to populate the “B/f 
per accounts” column on 
‘J’ for any current tax 
amounts.   

The deferred tax brought 
forward figures should be 
entered on ‘J4’ and they 
will pull through onto this 
sheet. On roll forward, all 
of the brought forward 
numbers will be populated 
automatically. 

Until these are populated 
you will have an amount 
showing in the “Difference 
in provision per the 
accounts” row. 

automatically populate the 
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3. Review the gross timing differences
 
Amounts on here will be linked either via 
computation. As mentioned earlier, we need to populate our brought forward per accounts values on this 
sheet.  These numbers should be entered manually, based on the numbers in your financial state
 

 
In our example we have presumed that the brought forward per accounts numbers are the same as our 
brought forward per comps values. If the numbers are not the same, then 
prior year adjustment automatically for you.
 
Please note: 
 

• If any of these gross timing differences 
be recognised at all, then they also need to be entered in the relevant column.
items are treated as “Recognised in I/S”.

 

• You will also need to allocate any amounts in the “Opening per computation” and
accounts” sections to Equity, OCI or not recognised if relevant. 
accounts columns will all be populated automatically (including any amounts allocated to Equity, 
OCI or not recognised) however 
be allocated to Equity, OCI or 
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ross timing differences – J4 

Amounts on here will be linked either via ‘JW2’ (Fixed asset timing differences) or straight from the tax 
s mentioned earlier, we need to populate our brought forward per accounts values on this 

should be entered manually, based on the numbers in your financial state

that the brought forward per accounts numbers are the same as our 
If the numbers are not the same, then ONESOURCE

prior year adjustment automatically for you.  

gross timing differences relate to balances in Equity or OCI, or perhaps should
, then they also need to be entered in the relevant column.  
“Recognised in I/S”. 

ou will also need to allocate any amounts in the “Opening per computation” and
to Equity, OCI or not recognised if relevant.  On roll forward, the opening per 

accounts columns will all be populated automatically (including any amounts allocated to Equity, 
OCI or not recognised) however if there are any “Opening per computation” amounts 

llocated to Equity, OCI or not recognised, these will need to be entered as appropriate.

(Fixed asset timing differences) or straight from the tax 
s mentioned earlier, we need to populate our brought forward per accounts values on this 

should be entered manually, based on the numbers in your financial statements.  

  

that the brought forward per accounts numbers are the same as our 
ONESOURCE will calculate a 

, or perhaps should not 
 By default, all 

ou will also need to allocate any amounts in the “Opening per computation” and “Closing per 
On roll forward, the opening per 

accounts columns will all be populated automatically (including any amounts allocated to Equity, 
“Opening per computation” amounts that need to 

not recognised, these will need to be entered as appropriate.  
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4. Review the fixed asset timing differences
 
The fixed asset timing differences row
pulls together and amalgamates all 
and calculates the overall gross timing difference
including all the figures we would expect.
 

 
Amounts in respect of non qualifying assets are pulled through from the draft computation where they can 
be identified, namely non qualifying additions and disposals. 
qualifying assets needs to be entered manually.
through automatically, but in our example there is also some non qualifying depreciation in respect of that 
asset.  This should be entered on ‘JW3
be stripped out of the qualifying fixed asset timing differences can also be entered on JW3.
 

 
If we go back to JW2 you can see that the depreciation 
 

Quick Reference Guide 

ixed asset timing differences 

row on ‘J4’ is supported by ‘JW2’ (Fixed asset timing differences)
 the information from the tax computation in respect of fixed assets 

gross timing difference.  We can take a look at this sheet to ensure this 
expect. 

 

Amounts in respect of non qualifying assets are pulled through from the draft computation where they can 
be identified, namely non qualifying additions and disposals.  All other information in respect of non
qualifying assets needs to be entered manually.  As can be seen, the non qualifying additions have pulled 
through automatically, but in our example there is also some non qualifying depreciation in respect of that 

JW3’.  Any other non qualifying expenditure or amounts 
be stripped out of the qualifying fixed asset timing differences can also be entered on JW3.

ck to JW2 you can see that the depreciation has now been adjusted for. 

 

Amounts from the Fixed 
Assets sheet (‘C’) and the 
capital allowance pools have 
been linked through 
automatically. 

 

(Fixed asset timing differences) which 
nformation from the tax computation in respect of fixed assets 

We can take a look at this sheet to ensure this is 

Amounts in respect of non qualifying assets are pulled through from the draft computation where they can 
All other information in respect of non-

As can be seen, the non qualifying additions have pulled 
through automatically, but in our example there is also some non qualifying depreciation in respect of that 

Any other non qualifying expenditure or amounts that need to 
be stripped out of the qualifying fixed asset timing differences can also be entered on JW3. 

 

mounts from the Fixed 
Assets sheet (‘C’) and the 
capital allowance pools have 
been linked through 
automatically.  
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For this example, as the fixed asset timing differences are n

 
5. Review the short term timing difference and losses
 
The balances pull through directly from the computation sheets for timing differences and losses therefore 
there are no supporting sheets required for these.
differences are complete.  Now you can 
 
6. Review the net timing differences
 

Note: No data entry should be required on here as this sheet applies a tax rate to the gross 
timing differences from ‘J4
 
The default rate used is either 12.5% or 25% depending on the rate at which the 
assets/liabilities are expected to reverse.
 

 
You can override the rates at which the deferred tax balances are recognised on t
the sheet, on a line by line basis.  In 
25%, so we will not be making any changes.
 

 
7. Check the proof of tax - J3 
 
Now that we are happy that our deferred tax is correct, 
This sheet reconciles the expected tax charge based on the profit or loss per the accounts, with the 
tax charge per the accounts.  The rate used for the reconciliation is set on 
that the higher non-trading income rate of 

Quick Reference Guide 

the fixed asset timing differences are now complete, we can go back to 

hort term timing difference and losses 

The balances pull through directly from the computation sheets for timing differences and losses therefore 
there are no supporting sheets required for these.  In this example, we are happy that all 

Now you can move onto Net timing differences. 

et timing differences - J5 

No data entry should be required on here as this sheet applies a tax rate to the gross 
J4’ to calculate the deferred tax balances for the accounts.

The default rate used is either 12.5% or 25% depending on the rate at which the 
sets/liabilities are expected to reverse. 

ou can override the rates at which the deferred tax balances are recognised on the right hand side of 
In this example, everything should be recognised at either 12.5% or 

will not be making any changes. 

 

deferred tax is correct, we should check that the Proof of tax reconciles.
the expected tax charge based on the profit or loss per the accounts, with the 

The rate used for the reconciliation is set on ‘JW’.  It is here 
rate of 25% could be chosen rather than trading income rate of 12.5%

can go back to ‘J4’. 

The balances pull through directly from the computation sheets for timing differences and losses therefore 
happy that all our gross timing 

No data entry should be required on here as this sheet applies a tax rate to the gross 
to calculate the deferred tax balances for the accounts. 

The default rate used is either 12.5% or 25% depending on the rate at which the 

he right hand side of 
example, everything should be recognised at either 12.5% or 

 

should check that the Proof of tax reconciles.  
the expected tax charge based on the profit or loss per the accounts, with the actual 

It is here for example 
rather than trading income rate of 12.5%. 
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As we can see below, in this example, we have permanent items as these are always reconciling items. 
We also have some non-trading income taxed at a rate above the 
rec at. 
 

 
 
You may have reconciling errors if non
need to be picked up in the reconciliation. 
must be allocated to the Equity or OCI column on 
 
There are columns to the right hand side of the sheet which make up the disclosure captions in the 
reconciliation of total tax charge in the accounts disclosures on 
if required. ONESOURCE will generally allocate reconciling items to a specific column automatically, 
based on the nature of the item, but you can re
disclosure you require. 
 
  

Quick Reference Guide 

in this example, we have permanent items as these are always reconciling items. 
income taxed at a rate above the trading income rate of 12.5%

You may have reconciling errors if non-standard adjustments have been made in the tax computation and 
need to be picked up in the reconciliation.  If you have amounts charged to Equity or OCI, then these 
must be allocated to the Equity or OCI column on ‘J’ to ensure ‘J3’ reconciles. 

There are columns to the right hand side of the sheet which make up the disclosure captions in the 
otal tax charge in the accounts disclosures on ‘J2’. These can be amended on this sheet 

will generally allocate reconciling items to a specific column automatically, 
based on the nature of the item, but you can re-allocate between columns as you see fit to get the 

 

in this example, we have permanent items as these are always reconciling items.  
rate of 12.5% chosen to 

 

standard adjustments have been made in the tax computation and 
If you have amounts charged to Equity or OCI, then these 

There are columns to the right hand side of the sheet which make up the disclosure captions in the 
. These can be amended on this sheet 

will generally allocate reconciling items to a specific column automatically, 
lumns as you see fit to get the 
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8. Revisit tax account - J  
 
Now that you have completed your tax accounting numbers
column on the Tax Account. As we 
provided. 
 
9. Review accounts disclosures - J2  
 
Now we have finished the tax accounting, 
 
This sheet will prepare the supporting tax notes for the income statement
the reconciliation to total tax charge.
 

Quick Reference Guide 

tax accounting numbers, you must complete the “C/F 
 agree with the figures in the “C/F per comps” column

J2   

have finished the tax accounting, let’s review our disclosures on ‘J2’. 

ll prepare the supporting tax notes for the income statement and balance sheet
the reconciliation to total tax charge. 

 

Limited data entry should 
be required on this sheet; 
however, there is a 
section for splitting 
deferred tax assets and 
liabilities between those 
recoverable within 12 
months, and those 
12 months. 

/F per accounts” 
per comps” column, click the button 

and balance sheet, including 

Limited data entry should 
be required on this sheet; 
however, there is a 
section for splitting 
deferred tax assets and 
liabilities between those 
recoverable within 12 

those after 
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10. Freeze tax accounting sheets  
 
Once the tax reporting process is complete and you want to update the tax computation for filing 
purposes, you may wish to freeze the 
 
Tools > Application tools > Freeze values on tax accounting sheets
 
Options are also given to archive the whole file (creates a copy of the file) and to hide the 

  

Quick Reference Guide 

 

 

Once the tax reporting process is complete and you want to update the tax computation for filing 
purposes, you may wish to freeze the ‘J’ sheets so that the values do not change.  To do this, go to

Freeze values on tax accounting sheets 

Options are also given to archive the whole file (creates a copy of the file) and to hide the 

As ONESOURCE does 
not know when deferred 
tax assets or liabilities 
will reverse, it 
automatically treats 
them as being 
recoverable within 12 
months.  If they are 
recoverable after
months, then you should 
manually reallocate 
them in the cells 
provided. 
 

Once the tax reporting process is complete and you want to update the tax computation for filing 
To do this, go to: 

Options are also given to archive the whole file (creates a copy of the file) and to hide the ‘J’ sheets. 

As ONESOURCE does 
not know when deferred 
tax assets or liabilities 
will reverse, it 
automatically treats 
them as being 
recoverable within 12 
months.  If they are 
recoverable after 12 
months, then you should 

reallocate 
them in the cells 
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LIMITATIONS 

Pensions 
There is currently no provision to separate
pension schemes deductible on a paid basis

Transfers in of assets at Tax Written Down Value (“TWDV”)
Transfers in at TWDV are currently not separat
the TWDV of the asset transferred in the “TWDV b/fwd” column on 
rows on ‘C’.  This is shown below for an asset transferred in with NBV of 
 

 
 
You will then need to adjust ‘JW2’ to allow for the difference.  The
be entered at the bottom of ‘JW2’ and
brought forward and TWDV Transfers in columns:
 

Quick Reference Guide 

separately track in the main computation movements in
emes deductible on a paid basis.  These movements can be manually entered on

Transfers in of assets at Tax Written Down Value (“TWDV”) 
Transfers in at TWDV are currently not separately supported in the fixed asset sheets; you

TWDV of the asset transferred in the “TWDV b/fwd” column on ‘B’ and the NBV in one of the 
below for an asset transferred in with NBV of €1m and TWDV of 

to allow for the difference.  The NBV of the asset transfer
and an adjustment included on an “Other...” row to adjust the TWDV 

brought forward and TWDV Transfers in columns: 

in reserves for 
can be manually entered onto ‘J4’. 

you should enter 
in one of the “Other...” 

1m and TWDV of €800k. 

 

transferred in should 
adjust the TWDV 
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Start up relief 
No deferred tax amounts are currently included for start-up relief. 

Research & development 
Following professional advice, enhanced research and development set-off amounts and credits do not 
flow through to the current tax line in the Tax account sheet.  We welcome your feedback as thinking in 
this area develops. 

Capital losses 
These are not currently brought onto ‘J4’ and a manual line should be added. 

Expenses not specifially disallowed in investment companies 
If expenses of an investment company are not allowable for tax purposes users may either categorise 
and disallow these (for example, create a supporting management expenses schedule and do not include 
the expense in the “Allowable Management Expenses” column) or in some cases may just leave them in 
the P&L unlinked to the rest of the computation. 
 
In the latter situation, the unallowable expense cannot be automatically picked up by the tax 
reconciliation.  To overcome this, users can either make sure all expenses are “properly” disallowed or 
alternatively can add a manual row to the reconciliation. 

Fixed assets across multiple trades at different rates 
While the TWDV of assets in each trade are separately tracked, the NBV is not.  A single line is therefore 
included on ‘J4’ for all assets qualifying for capital allowances.  Where some of these are part of, for 
example, an excepted mining trade (taxable at 25%) and the remainder in a standard rated trade, a 
manual adjustment will be needed on ‘J4’ to split these out.  An alternative is to enter a blended rate on 
‘J5’. 

Profits taxed at 12.5% trading income rate and a 25% reconcilliation rate is used 
Where a company has trading profits taxed at 12.5% and is preparing reconciliation at 25% an 
adjustment has to be brought onto ‘J3’ to show the lower rate of tax suffered on those trading profits.   
Any timing difference in relation to that profit is brought onto ‘J5’ and as the rate at which you would 
normally want to recognize deferred tax differs from the reconciliation rate chosen, an “I/S rate difference” 
is generated on ‘J5’ and taken to ‘J3’ as a reconciling item.    
 
An example below shows a trade taxable at 12.5% with a €10m provision expense with €1m of this being 
general in nature (i.e. deductible but in a later period):  
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Where you do not want an I/S rate difference shown you

Rate and Standard Tax Rate on ‘J5

of 25% in our example: 

 
This override will prevent a reconciling item appearing on 

added to ‘J3’ to compensate i.e. to gro

example): 

 
The above changes won’t affect the tax payable or tax reconciliation as a whole but may better disclose 
the reason for the tax difference. 
 
This currently affects timing differences caused by:
 

• IP trade deductions being deferred

• Charges not paid during the period

• Defined benefit pension expense not paid during the period

  

Quick Reference Guide 

n I/S rate difference shown you could instead override the Current Period Tax 

J5’ for the item concerned which have defaulted to the reconciliation rate 

This override will prevent a reconciling item appearing on ‘J3’ and so a manual line will now need to be 

to gross up the profits/loss taxed/relieved at 12.5% (a €

The above changes won’t affect the tax payable or tax reconciliation as a whole but may better disclose 

ences caused by: 

IP trade deductions being deferred 

Charges not paid during the period 

Defined benefit pension expense not paid during the period 

could instead override the Current Period Tax 

for the item concerned which have defaulted to the reconciliation rate 

 

and so a manual line will now need to be 

€10m loss in our 

 

The above changes won’t affect the tax payable or tax reconciliation as a whole but may better disclose 
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Investment companies not using a 25% reconcilliation rate
Similarly, issues arise when the reconciliation is performed for an investment company at a rate other 
than that normally applicable to non
In the following example the investment company has
charges of the same, with €1m of the charges not paid during the period.  As there are no permanent 
differences, reconciliation at 25% will show no reconciling items.
 
If instead, the reconciliation is carried out 
the charges are deductible at 25% with another line brought in from 
difference: 
 

 
As before, if preferred, the default tax rates on 
‘J3’: 
 

Quick Reference Guide 

Investment companies not using a 25% reconcilliation rate 
Similarly, issues arise when the reconciliation is performed for an investment company at a rate other 
than that normally applicable to non-trading income/expenses e.g. if 12.5% is used rather than 25%.  
In the following example the investment company has non-trading income of €10m and non

€1m of the charges not paid during the period.  As there are no permanent 
differences, reconciliation at 25% will show no reconciling items. 

If instead, the reconciliation is carried out at 12.5%, a line is automatically brought in to show that 
the charges are deductible at 25% with another line brought in from ‘J5’ to show a deferred tax rate 

As before, if preferred, the default tax rates on ‘J5’ can be overidden and a manual line instead added to 

Similarly, issues arise when the reconciliation is performed for an investment company at a rate other 
trading income/expenses e.g. if 12.5% is used rather than 25%.   

10m and non-trade 
1m of the charges not paid during the period.  As there are no permanent 

at 12.5%, a line is automatically brought in to show that €9m of 
to show a deferred tax rate 

 

d a manual line instead added to 
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Motor vehicles – limits on allowable expenditure
The restriction of capital allowances for motor vehicle costing in excess of 
main computation, however, the Net Book Value of this unall
The non-allowable portion of any additions are automatically taken to ‘JW3’ but users will need to enter 
any depreciation or disposal proceeds on the same sheet.
 
The example below shows a €100k vehicle purchased 
 

 
The €50k car acquired in 2015 flows through to ‘JW3’ but the NBV of the non
2014 car will need to be entered (€76k assuming no depreciation):
 

 
Restricted proceeds are automatically taken fr
calculate the profit or loss on disposal on the unallowable portion.  This 
tax reconciliation on ‘J3’ (€76,000 NBV less 
 

Quick Reference Guide 

limits on allowable expenditure 
The restriction of capital allowances for motor vehicle costing in excess of €24,000 is dealt with by the 
main computation, however, the Net Book Value of this unallowable portion is not separately tracked.  

allowable portion of any additions are automatically taken to ‘JW3’ but users will need to enter 
any depreciation or disposal proceeds on the same sheet. 

€100k vehicle purchased in 2014 and sold in 2015 for €40k.

50k car acquired in 2015 flows through to ‘JW3’ but the NBV of the non-allowable portion of the 
€76k assuming no depreciation): 

Restricted proceeds are automatically taken from the computation and combined with the NBV entered to 
calculate the profit or loss on disposal on the unallowable portion.  This automatically feeds through to the 

76,000 NBV less €30,400 proceeds): 

24,000 is dealt with by the 
owable portion is not separately tracked.  

allowable portion of any additions are automatically taken to ‘JW3’ but users will need to enter 

€40k. 

 

allowable portion of the 

 

om the computation and combined with the NBV entered to 
feeds through to the 

 


